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Legal Information

Limited Warranty
This document is provided ‘as is’ and is subject to being changed, without notice, in future editions. For the latest version, 
refer to ni.com/manuals. NI reviews this document carefully for technical accuracy; however, NI MAKES NO EXPRESS 
OR IMPLIED WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND 
SHALL NOT BE LIABLE FOR ANY ERRORS.

NI warrants that its hardware products will be free of defects in materials and workmanship that cause the product to fail to 
substantially conform to the applicable NI published specifications for one (1) year from the date of invoice.

For a period of ninety (90) days from the date of invoice, NI warrants that (i) its software products will perform substantially 
in accordance with the applicable documentation provided with the software and (ii) the software media will be free from 
defects in materials and workmanship.

If NI receives notice of a defect or non-conformance during the applicable warranty period, NI will, in its discretion: (i) repair 
or replace the affected product, or (ii) refund the fees paid for the affected product. Repaired or replaced Hardware will be 
warranted for the remainder of the original warranty period or ninety (90) days, whichever is longer. If NI elects to repair or 
replace the product, NI may use new or refurbished parts or products that are equivalent to new in performance and reliability 
and are at least functionally equivalent to the original part or product.

You must obtain an RMA number from NI before returning any product to NI. NI reserves the right to charge a fee for 
examining and testing Hardware not covered by the Limited Warranty.

This Limited Warranty does not apply if the defect of the product resulted from improper or inadequate maintenance, 
installation, repair, or calibration (performed by a party other than NI); unauthorized modification; improper environment; 
use of an improper hardware or software key; improper use or operation outside of the specification for the product; improper 
voltages; accident, abuse, or neglect; or a hazard such as lightning, flood, or other act of nature.

THE REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND THE CUSTOMER’S SOLE REMEDIES, AND SHALL 
APPLY EVEN IF SUCH REMEDIES FAIL OF THEIR ESSENTIAL PURPOSE.

EXCEPT AS EXPRESSLY SET FORTH HEREIN, PRODUCTS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF 
ANY KIND AND NI DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, WITH RESPECT TO THE 
PRODUCTS, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, TITLE OR NON-INFRINGEMENT, AND ANY WARRANTIES THAT MAY ARISE FROM 
USAGE OF TRADE OR COURSE OF DEALING. NI DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE OF OR THE RESULTS OF THE USE OF THE PRODUCTS IN TERMS 
OF CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NI DOES NOT WARRANT THAT THE 
OPERATION OF THE PRODUCTS WILL BE UNINTERRUPTED OR ERROR FREE.

In the event that you and NI have a separate signed written agreement with warranty terms covering the products, then the 
warranty terms in the separate agreement shall control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the 
prior written consent of National Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected 
by copyright and other intellectual property laws. Where NI software may be used to reproduce software or other materials 
belonging to others, you may use NI software only to reproduce materials that you may reproduce in accordance with the 
terms of any applicable license or other legal restriction.

End-User License Agreements and Third-Party Legal Notices
You can find end-user license agreements (EULAs) and third-party legal notices in the following locations:

• Notices are located in the <National Instruments>\_Legal Information and <National Instruments> 
directories.

• EULAs are located in the <National Instruments>\Shared\MDF\Legal\license directory.

• Review <National Instruments>\_Legal Information.txt for information on including legal information in 
installers built with NI products.

U.S. Government Restricted Rights
If you are an agency, department, or other entity of the United States Government (“Government”), the use, duplication, 
reproduction, release, modification, disclosure or transfer of the technical data included in this manual is governed by the 
Restricted Rights provisions under Federal Acquisition Regulation 52.227-14 for civilian agencies and Defense Federal 
Acquisition Regulation Supplement Section 252.227-7014 and 252.227-7015 for military agencies.

Trademarks
Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for more information on NI trademarks.

ARM, Keil, and µVision are trademarks or registered of ARM Ltd or its subsidiaries.

LEGO, the LEGO logo, WEDO, and MINDSTORMS are trademarks of the LEGO Group.

TETRIX by Pitsco is a trademark of Pitsco, Inc.

FIELDBUS FOUNDATION™ and FOUNDATION™ are trademarks of the Fieldbus Foundation.

EtherCAT® is a registered trademark of and licensed by Beckhoff Automation GmbH.
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CANopen® is a registered Community Trademark of CAN in Automation e.V.

DeviceNet™ and EtherNet/IP™ are trademarks of ODVA.

Go!, SensorDAQ, and Vernier are registered trademarks of Vernier Software & Technology. Vernier Software & Technology 
and vernier.com are trademarks or trade dress.

Xilinx is the registered trademark of Xilinx, Inc.

Taptite and Trilobular are registered trademarks of Research Engineering & Manufacturing Inc.

FireWire® is the registered trademark of Apple Inc.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Handle Graphics®, MATLAB®, Simulink®, Stateflow®, and xPC TargetBox® are registered trademarks, and 
Simulink Coder™, TargetBox™, and Target Language Compiler™ are trademarks of The MathWorks, Inc.

Tektronix®, Tek, and Tektronix, Enabling Technology are registered trademarks of Tektronix, Inc.

The Bluetooth® word mark is a registered trademark owned by the Bluetooth SIG, Inc.

The ExpressCard™ word mark and logos are owned by PCMCIA and any use of such marks by National Instruments is under 
license.

The mark LabWindows is used under a license from Microsoft Corporation. Windows is a registered trademark of Microsoft 
Corporation in the United States and other countries.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from NI and have no 
agency, partnership, or joint-venture relationship with NI.

Patents
For patents covering NI products/technology, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents.

Export Compliance Information
Refer to the Export Compliance Information at ni.com/legal/export-compliance for the NI global trade compliance 
policy and how to obtain relevant HTS codes, ECCNs, and other import/export data.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
YOU ARE ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY AND 
RELIABILITY OF THE PRODUCTS WHENEVER THE PRODUCTS ARE INCORPORATED IN YOUR SYSTEM OR 
APPLICATION, INCLUDING THE APPROPRIATE DESIGN, PROCESS, AND SAFETY LEVEL OF SUCH SYSTEM 
OR APPLICATION.

PRODUCTS ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE IN LIFE OR SAFETY CRITICAL 
SYSTEMS, HAZARDOUS ENVIRONMENTS OR ANY OTHER ENVIRONMENTS REQUIRING FAIL-SAFE 
PERFORMANCE, INCLUDING IN THE OPERATION OF NUCLEAR FACILITIES; AIRCRAFT NAVIGATION; AIR 
TRAFFIC CONTROL SYSTEMS; LIFE SAVING OR LIFE SUSTAINING SYSTEMS OR SUCH OTHER MEDICAL 
DEVICES; OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF THE PRODUCT OR SERVICE COULD 
LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR ENVIRONMENTAL HARM 
(COLLECTIVELY, “HIGH-RISK USES”). FURTHER, PRUDENT STEPS MUST BE TAKEN TO PROTECT AGAINST 
FAILURES, INCLUDING PROVIDING BACK-UP AND SHUT-DOWN MECHANISMS. NI EXPRESSLY DISCLAIMS 
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK 
USES.
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1
Introduction to 
NI Requirements Gateway

NI Requirements Gateway is a requirements traceability solution that links development and 
verification documents with formal requirements defined in documents and databases. 
Requirements Gateway improves the quality of the development process by effectively 
managing requirements traceability and impact analysis throughout the life cycle of a project.

Most engineering projects initially define high-level specifications and later define more 
detailed specifications. Specifications contain technical and procedural requirements that guide 
the product through each engineering phase. In addition, working documents, such as hardware 
schematics, simulation models, software source code, and test specifications and procedures, 
must adhere to and cover the requirements the specifications define.

You can use Requirements Gateway to link traceability information from external applications, 
as shown in Figure 1-1, to cover project requirements and to complete the following types 
of tasks:

• Configure the specifications and working documents you want to analyze using built-in or 
custom document interfaces, called types in Requirements Gateway

• Specify the traceability information, such as requirements or references that cover 
requirements, that you want to capture from each document

• Specify the traceability relationships between the specifications and working documents

• Use Coverage Analysis, Impact Analysis, and Graphical views to visualize and analyze 
traceability relationships between documents

• Create filters to customize the display or analysis of traceability

• Capture and compare project snapshots to determine changes in requirements and coverage

• Generate reports using built-in or custom report models and templates

• Navigate between Requirements Gateway and external applications to edit documents
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Figure 1-1.  Linking Traceability Information from External Applications

Refer to the NI Requirements Gateway Help for more information about Requirements Gateway 
features. Select Help»NI Requirements Gateway Help in the Requirements Gateway main 
window to access the NI Requirements Gateway Help.

Use the Guide to Requirements Gateway Documentation in the NI Requirements Gateway Help 
to access all the documentation in electronic format. Select Help»Guide to Documentation in 
the main window to access the Guide to Requirements Gateway Documentation in the 
NI Requirements Gateway Help.

Starting Requirements Gateway
The Requirements Gateway interface includes a main window, in which you perform coverage 
and impact analysis, and a Configuration dialog box, in which you create and modify project 
documents, types, filters, and other options. Refer to the NI Requirements Gateway Help for 
more information about the main window and the Configuration dialog box.

NI Requirements Gateway 

Traceability

Specification Documents or Databases

PDFPDFPDF DOORSDOORSDOORS AccessAccessAccess

TestStand LabVIEW LabWindows/CVILabVIEW UTF

Working Documents

Requirements
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Main Window
The main window displays when you launch Requirements Gateway, and includes the 
components shown in Figure 1-2.

Figure 1-2.  Main Window

Menu Bar
The menu bar contains the File, Edit, View, Tools, Reports, and Help menus.

Toolbar
The toolbar contains options for common tasks and includes the following sections, as shown in 
Figure 1-3.

Figure 1-3.  Main Window Toolbar

• Standard—Contains buttons for creating, loading, and saving project files.

• Configuration—Contains buttons for configuring projects, types, snapshots, and options.

1 Menu Bar
2 Toolbar

3 Project Workspace
4 Status Bar

1 Standard
2 Configuration

3 Navigation
4 View Options

5 Filtering
6 Third Party

1

4

2

3

1 42 3 65
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• Navigation—Contains buttons to apply navigation commands previously performed 
within the coverage information of the Coverage Analysis and Impact Analysis views. This 
section is available only in the Coverage Analysis, Impact Analysis, Graphical, and 
Requirement Details views.

• View Options—Contains buttons to control the visible traceability elements in the 
Coverage Analysis and Impact Analysis views.

• Filtering—Contains options for applying or configuring filters that display or hide 
requirements in an analysis or view.

• Third Party—Contains buttons for exporting traceability information to third party 
applications, such as IBM Rational DOORS, if available. You must install and have access 
to the third party application on the same computer as Requirements Gateway for the 
buttons to become available.

Project Workspace
The project workspace displays the project information and analysis for the loaded project. The 
project workspace contains tabs for displaying the content of the project in the following views:

• Feature Management—Defines features and releases in a project, assigns requirements, 
macro-requirements, or sub-features, and adds attributes to features and releases.

• Management—Graphically summarizes the documents and requirements in the project, 
and displays an overall percentage of requirement coverage for the project. Refer to 
Chapter 2, Managing Requirements, for more information about using the Management 
view to review documents requirements in a project.

• Coverage Analysis—Displays one level of covering elements at the immediate 
downstream level, N–1, for a selected element of a document, and one level of covered 
elements at the immediate upstream level, N+1, from other documents as the project 
defines. Refer to Chapter 3, Analyzing Requirements, for more information about using the 
Coverage Analysis view.

• Impact Analysis—Displays all levels of covering elements at downstream levels, N–m, for 
a selected element of a document, and all levels of covered elements at upstream levels, 
N+p, from other documents as the project defines. Refer to Chapter 3, Analyzing 
Requirements, for more information about using the Impact Analysis view.

• Graphical—Graphically displays each document using a tree view, in which lines connect 
requirements in documents and covering elements in other documents. Refer to Chapter 3, 
Analyzing Requirements, for more information about using the Graphical view.

• Requirement Details—Displays each requirement and its attributes for a document.

• Link Details—Allows you to create additional references between requirements and 
covering documents without modifying project document source files.

Status Bar
The status bar displays common application information, such as analysis status or a brief 
description of a menu item when you hover over the item in the menu bar.
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Configuration Dialog Box
Requirements Gateway launches the Configuration dialog box, as shown in Figure 1-4, when 
you select a menu item or toolbar button in the main window to complete one of the following 
tasks:

• Edit a project

• Edit document types

• Edit snapshots

• Edit analysis display filters

• Edit reports

• Configure project options

Figure 1-4.  Configuration Dialog Box

The Configuration dialog box contains the following panes:

• Project—Configure a project by specifying the documents to include, the type of each 
document, and the covering relationship between documents. Refer to Chapter 2, 
Managing Requirements, for more information about configuring projects.

• Types—Review built-in types, customize built-in types, or create new types for the project. 
Refer to Chapter 5, Customizing Types, for more information about customizing types.
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• Snapshots—Create, manage, and compare snapshots of the project. A snapshot is a stored 
image of analysis results you can use to trace modifications, additions, or deletions of 
information throughout the lifetime of the project.

• Filters—Define custom filters to analyze or display certain requirements from documents 
that meet specific criteria. You can enable filters using the Filter Selection ring control on 
the toolbar in the main window.

• Reports—Review built-in report models, customize built-in report models, or create new 
report models. You can use the options in the Reports menu on the toolbar in the main 
window to generate a report. Refer to Chapter 4, Generating Reports, for more information 
about generating reports and creating custom reports.

• Expressions—Test the regular expressions you define for custom types you create on the 
Types pane to ensure the expressions accurately capture the appropriate elements before 
you use the expressions in a project. You can specify text from a project document source 
file and a regular expression, and the pane displays the traceability information the regular 
expression returns.

• XML—Test the XML syntax you define to ensure the XML syntax accurately captures the 
appropriate elements before you use the XML syntax in a project.

• Options—Specify the default font for the text in the application, specify a password for the 
project, define environmental variables, define user profiles for connecting to a DOORS 
database, and specify other settings for Requirements Gateway.

Refer to the NI Requirements Gateway Help for more information about configuring projects, 
customizing types, creating snapshots, specifying filters, generating reports, and using regular 
expressions.

Requirements Gateway Directory Structure
Requirements Gateway installs files in the following directories:

• <Requirements Gateway>—Located by default at C:\Program Files\
National Instruments\Requirements Gateway on Microsoft Windows 32-bit 
systems and at C:\Program Files (x86)\National Instruments\
Requirements Gateway on Windows 64-bit systems.

The <Requirements Gateway> directory is the location where you installed 
Requirements Gateway on the computer and contains the read-only Requirements Gateway 
program files.

• <Requirements Gateway Public>—Located by default at C:\Users\Public\
Public Documents\National Instruments\Requirements Gateway.

The <Requirements Gateway Public> directory contains writable files such as 
custom types, custom report models and templates, the tutorials in this manual, and other 
examples.
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Managing Requirements

You can use the Configuration dialog box to create a project and add existing documents to the 
project, and you can use the main window to review the content of the documents.

A project specifies the documents Requirements Gateway analyzes, the type to use for each 
document, and the covering links between the documents. A type defines how Requirements 
Gateway completes the following tasks:

• Selects the source files for a project document. For example, a project document of the 
LabVIEW type selects a LabVIEW VI, project file, class file, project library, or LLB as the 
source file.

• Reads and analyzes the content of the source files for traceability information.

• Displays the elements of the document.

Requirements Gateway includes a set of built-in types for capturing traceability information 
from National Instruments applications, such as LabVIEW, LabWindows™/CVI™, and 
NI TestStand™, and from other common data sources, such as Microsoft Office documents, PDF 
files, text files, and source code files. Refer to Chapter 6, Using External Applications with 
Requirements Gateway, for a complete list of applications and data sources Requirements 
Gateway supports.

Creating a Project 
Complete the following steps to start Requirements Gateway and create a new project.

Note The exercises in this manual modify the tutorial files located in the 
<Requirements Gateway Public>\Tutorials directory. You can restore the 
tutorial files to the original state by copying the files from the <Requirements 
Gateway Public>\Tutorials\Original directory to the <Requirements 
Gateway Public>\Tutorials directory.

1. Select Start»All Programs»National Instruments»Requirements Gateway»
Requirements Gateway to launch Requirements Gateway and display the main window.

2. Select File»New or click the New button, as shown in the following figure, on the toolbar 
in the main window to launch the Create a New Project and Save As dialog box, and 
navigate to the <Requirements Gateway Public>\Tutorials directory.

3. Enter MyProject in the File name control and click Save.
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Requirements Gateway creates a new project file (.rqtf) and displays the Project pane of the 
Configuration dialog box, as shown in Figure 2-1. A project file defines the documents 
Requirements Gateway analyzes, the type of each document, and the covering relationship 
between the documents. If you do not add documents to the project file, Requirements Gateway 
does not save the project file to disk and discards the file in memory. After you add documents 
to the project and apply the changes, Requirements Gateway saves the project file in the 
<Requirements Gateway Public>\Tutorials directory.

Figure 2-1.  New Project on the Project Pane of the Configuration Dialog Box

The Project pane contains the following sections:

• Project Files—Tree view of all the documents and folders the root project directory 
contains. Each document in the project tree displays the document name and an icon that 
indicates the document type.

• Project Configuration—Graphical overview of the documents and folders in the project. 
You can place and arrange documents and folders, and you can add covering links between 
the project documents to specify a covering relationship between the documents.

1 Project Files
2 Project Configuration

3 Project Options
4 Document Options

1

3

4

2
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• Project Options—Options for adding folders, documents, modification files, and covering 
links to a project, and an option for removing selected items from the project. Refer to the 
NI Requirements Gateway Help for more information about adding folders and 
modification files to a project.

• Document Options—Options for configuring a selected project document, modification 
file, or covering link.

Adding a Document
Complete the following steps to add a specification document to the project you created in the 
Creating a Project section of this chapter.

1. Click the Add a document button, as shown in the following figure. The cursor 
automatically moves to the Project Configuration pane and outlines a document object. 
Click the Project Configuration pane to place the document.

When you place the document, Requirements Gateway adds the document to the Project 
Files list. The Details tab of the Document Options pane displays the settings for the 
document.

2. On the Details tab of the Document Options pane, click in the Name column to select the 
Document1 text. Enter Product Specification and press <Enter> to rename the 
document.

3. Click in the Type of Analysis column and select Text from the ring control to analyze the 
document using the Text type.

The Text type specifies that the document is a text file, the content of which follows a 
specific format for defining traceability information. Requirements Gateway analyzes the 
text file for text that follows the format the Text type defines. Other types define unique 
formats for capturing traceability information from other data sources.

The Reviewing the Product Specification Document section in this chapter demonstrates 
how to review a text file for the traceability information Requirements Gateway captures 
when it analyzes the text file.

4. Click in the File or Directory column. The File Browse button, as shown in the following 
figure, becomes visible on the right side of the control. Click the File Browse button, 
navigate to <Requirements Gateway Public>\Tutorials\ProductSpec.txt, 
and click Open. Figure 2-2 shows the Configuration dialog box after you add the Product 
Specification document.
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Figure 2-2.  Adding a Document to a Project

Adding a Covering Document
A covering document is a document that contains references to requirements that another 
document defines. A covering document can specify a source file from any supported external 
application, such as a TestStand sequence file, a LabVIEW VI, or a C file. For example, a step 
in a TestStand sequence might cover requirements defined in a text document.

Note This tutorial adds a covering text document. Refer to the NI Requirements 
Gateway Help for more information about adding documents from each supported 
external application, including TestStand, LabVIEW, and LabWindows/CVI.

Complete the following steps to add a new document to the project that covers the Product 
Specification document.

1. Click the Add a document button to add a second document on the Project Configuration 
pane. Place the document below the Product Specification document.

2. On the Details tab of the Document Options pane, enter Covering Specification in 
the Name control, select Text from the Type of Analysis ring control, and browse to 
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<Requirements Gateway Public>\Tutorials\CoveringSpec.txt in the File 
or Directory control.

3. Click the Add a cover button, as shown in the following figure.

Click the Covering Specification document and then click the Product Specification 
document. A covering link appears between the two documents, as shown in Figure 2-3. 
The arrow on the covering link indicates that the Covering Specification document covers 
the Product Specification document.

Figure 2-3.  Adding a Covering Document to a Project

4. Click OK to close the Configuration dialog box.
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Using the Management View
After you close the Configuration dialog box in step 4 of the Adding a Covering Document 
section, the Management view displays in the main window, as shown in Figure 2-4.

Figure 2-4.  Reviewing the Project in the Management View

The Overall Quality pane in the Management view indicates that the project includes 
two documents and specifies ten requirements, but one requirement remains uncovered. The 
Project Overview pane displays the covering relationship between the documents. 

Note Requirements Gateway declares a set of formal rules that define the required 
structure of project traceability and configuration information. When analyzing the 
project, Requirements Gateway identifies any violations of the rules and displays the 
results on the Rule Check pane in the Management view. Rule violations also display 
under a Rule check node in the Selection column of the Coverage Analysis and 
Impact Analysis views. Refer to the NI Requirements Gateway Help for lists of 
possible rule violations and recommendations for resolving the violations.

Complete the following tutorials to use the Management view to review the documents you 
included in the project.
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Reviewing the Product Specification Document
Complete the following steps to review the content of the Product Specification document.

1. Double-click the Product Specification document on the Project Overview pane. 
Requirements Gateway displays the source file for the Product Specification document, 
ProductSpec.txt, in the default application associated with .txt files, as shown in 
Figure 2-5. The default application for Microsoft Windows is Microsoft Notepad. You can 
also right-click this document and select Navigate from the context menu to open this 
document in the default application.

Figure 2-5.  ProductSpec.txt Document

2. Review the content of ProductSpec.txt, which specifies ten requirements.

Requirements Gateway uses the Text type applied to the document to analyze 
ProductSpec.txt and identify the following traceability elements:

• Sections—Defined by a numeric heading, such as 2.1. The text after the numeric 
heading is the text of the section.

• Requirements—Defined by an ID that contains a set of arbitrary characters, followed 
by the characters REQ, and ending with a numeric value. The label for the requirement 
is located after the ID, and the colon character delimits the label.

• Text—When delimited by the << and >> characters, the text is associated with the 
previously specified element. If an initial text element is specified at the beginning of 
the file, the text is associated with the document. Otherwise, the text is associated with 
a section or another element, such as a requirement.

1 General Text
2 Document Text

3 Section
4 Section Text

5 Requirement ID
6 Requirement Label

7 Requirement Text

3

1

5

7

6
4

2
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3. Exit the application that displays ProductSpec.txt.

4. In Requirements Gateway, click the Coverage Analysis View tab in the main window. 

5. Expand the child elements of the Product Specification document in the Selection column.

Note Press <Shift> while expanding the parent element to display all the child 
elements.

The Selection column displays the section headings from the Product Specification 
document as parent elements and the requirements as child elements, as shown in 
Figure 2-6. For example, the PS_USB_REQ1 and PS_USB_REQ2 elements represent 
requirements the Product Specification document specifies.

Figure 2-6.  Product Specification Document in the Coverage Analysis View 

6. Collapse the Product Specification document in the Selection column.
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Reviewing the Covering Specification Document
Complete the following steps to review the content of CoveringSpec.txt.

1. Click the Management View tab in the main window. 

2. Select the Covering Specification document on the Project Overview pane. Navigate to 
CoveringSpec.txt.

3. Review the content of CoveringSpec.txt, which contains section and text elements. 
Instead of requirements, the file contains references to requirements, as shown in 
Figure 2-7. The prefix [Covers:, followed by a set of characters that represent the 
requirement ID and completed with a closing bracket character, defines a reference.

Figure 2-7.  References in CoveringSpec.txt

The text file specifies nine references. The 1.2. USB 2.0 Speeds section of the file does not 
contain a reference.

4. Exit the application that displays CoveringSpec.txt.

5. In Requirements Gateway, click the Coverage Analysis View tab in the main window. 

1. USB Support
1.1. USB 1.0 Speeds
 <<Hardware supports USB 1.0>>
 [Covers: PS_USB_REQ1]

1.2. USB 2.0 Speeds

2. Channel Support
2.1. Analog Input
 <<Hardware supports analog input>>
 [Covers: PS_AI_REQ1]
 <<10 channels>>
 [Covers: PS_AI_REQ2]
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6. Expand the child elements of the Covering Specification document in the Selection 
column. The Selection column displays the sections the Covering Specification document 
specifies, as shown in Figure 2-8. Requirements Gateway highlights the 1.2 USB 
2.0 Speeds section in gray because this section is empty.

Figure 2-8.  Covering Specification Document in the Coverage Analysis View 

7. Collapse the Covering Specification document in the Selection column.

Refer to Chapter 3, Analyzing Requirements, for more information about using the Coverage 
Analysis view.
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Analyzing Requirements

Use the Coverage Analysis, Impact Analysis, and Graphical views to review the relationships 
between requirements and the references that cover requirements.

Using the Coverage Analysis View
The Selection column of the Coverage Analysis view displays the content of all the documents 
in the project. Select an element of a document in the Selection column to display only the 
immediate level of upstream elements the selected element covers in the Upstream Coverage 
Information column or only the immediate level of downstream elements that cover the selected 
element in the Downstream Information column.

The Coverage Analysis view also contains the following tabs. Each tab displays details about 
the element you select in the Selection column.

• Texts and Reference Attributes—Displays the text for the element you select and any 
attributes for references that link the element you select to a corresponding element in the 
Upstream Coverage Information or Downstream Coverage Information column.

• Attributes—Displays the attributes for the element you select.

• Messages—Displays helpful information, including rule violation details, for the element 
you select.

Refer to Chapter 5, Customizing Types, and to the NI Requirements Gateway Help for more 
information about attributes and reference attributes.

Complete the following tutorials to use the Coverage Analysis view to analyze requirement 
coverage for a project and add references to a project document.
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Analyzing Requirement Coverage
Complete the following steps to analyze requirement coverage for the project you created in 
Chapter 2, Managing Requirements.

1. Open <Requirements Gateway Public>\Tutorials\MyProject.rqtf if it is 
not already open.

2. Click the Coverage Analysis View tab in the main window. Collapse the Product 
Specification and the Covering Specification documents in the Selection column, as shown 
in Figure 3-1.

Figure 3-1.  Coverage Analysis View

3. Select the Product Specification document in the Selection column. The Downstream 
Coverage Information column indicates that the Covering Specification document covers 
90% of the requirements in the Product Specification document.

4. Expand the Product Specification document in the Selection column, and expand the 
1 USB Communication section element.
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5. Select the PS_USB_REQ1 requirement of the Product Specification document, as shown 
in Figure 3-2.

Figure 3-2.  PS_USB_REQ1 Selected in the Coverage Analysis View

The Downstream Coverage Information column displays the 1.1 USB 1.0 Speeds section 
as a covering element because this section of the Covering Specification document contains 
a reference to the PS_USB_REQ1 requirement. The Downstream Coverage Information 
column also displays the 1 USB Support parent section of the 1.1 USB 1.0 Speeds section.

6. Select the PS_USB_REQ2 requirement of the Product Specification document, as shown 
in Figure 3-3.

Figure 3-3.  PS_USB_REQ2 Selected in the Coverage Analysis View

The Downstream Coverage Information column does not display any covering elements 
because the Covering Specification document does not contain a reference to the 
PS_USB_REQ2 requirement.

7. Hover over the exclamation icon, as shown in the following figure, to the right of the 
PS_USB_REQ2 requirement to display a tooltip that contains the text 1 uncovered 
requirement. The Selection column displays the exclamation icon for an uncovered 
requirement and all the parent elements of the uncovered requirement.

Note You can also expand the Rule check node in the Selection column and 
expand the Uncovered requirement (1) rule violation. Requirements Gateway lists 
the PS_USB_REQ2 requirement as an uncovered requirement. You can double-click 
the PS_USB_REQ2 requirement under the Rule check node to locate the 
PS_USB_REQ2 requirement in the project document in the Selection column.
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8. Select and expand the 2 Analog Channels section of the Product Specification document, 
as shown in Figure 3-4. 

Figure 3-4.  2 Analog Channels Section Selected in the Coverage Analysis View

The 2.1 Analog Input child section of the 2 Analog Channels section contains the 
PS_AI_REQ1 and PS_AI_REQ2 requirements, and the 2.2 Analog Output child section 
contains the PS_AO_REQ1 and PS_AO_REQ2 requirements. The Downstream Coverage 
Information column displays the 2.1 Analog Input and 2.2 Analog Output sections of the 
Covering Specification document as covering elements. In the Covering Specification 
document, the 2.1 Analog Input section contains references to the PS_AI_REQ1 and 
PS_AI_REQ2 requirements, and the 2.2 Analog Output section contains references to the 
PS_AO_REQ1, and PS_AO_REQ2 requirements.

9. Double-click the 2.1 Analog Input section of the Covering Specification document in the 
Downstream Coverage Information column. Requirements Gateway selects the 2.1 Analog 
Input section of the Covering Specification document as the selected element in the 
Selection column, as shown in Figure 3-5. 

Figure 3-5.  2.1 Analog Input Section Selected in the Coverage Analysis View

The Upstream Coverage Information column indicates that the Covering Specification 
document covers 90% of the requirements in the Product Specification document, and that 
the references from the 2.1 Analog Input section of the Covering Specification document 
specifically cover the PS_AI_REQ1 and PS_AI_REQ2 requirements in the Product 
Specification document.
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Adding a Reference in a Project Document
Complete the following steps to add a reference in the Covering Specification document to cover 
the uncovered requirement, PS_USB_REQ2, in the Product Specification document.

1. Expand the 1 USB Support section of the Covering Specification document in the 
Selection column.

2. Double-click the 1.2 USB 2.0 Speeds element in the Selection column to navigate 
to CoveringSpec.txt.

3. Edit the file by adding a reference to the PS_USB_REQ2 requirement below the 
1.2. USB 2.0 Speeds section, as shown in Figure 3-6.

Figure 3-6.  PS_USB_REQ2 Reference in Covering Specification Document

4. Save the changes to CoveringSpec.txt and exit the application.

5. Return to Requirements Gateway, which launches a dialog box that indicates that the 
Covering Specification document was modified. Click Yes to reload the file. Requirements 
Gateway analyzes the new document and updates the view, as shown in Figure 3-7.

Figure 3-7.  Covering Specification Document after Reloading the Project

The Upstream Coverage Information column now indicates that the Covering Specification 
document covers 100% of the requirements in the Product Specification document. The 
Upstream Coverage Information column also indicates that the 1.2 USB 2.0 Speeds section 

1. USB Support
1.1. USB 1.0 Speeds
 <<Hardware supports USB 1.0>>
 [Covers: PS_USB_REQ1]

1.2. USB 2.0 Speeds
 <<Hardware supports USB 2.0>>
 [Covers: PS_USB_REQ2]

2. Channel Support
2.1. Analog Input
 <<Hardware supports analog input>>
 [Covers: PS_AI_REQ1]
 <<10 channels>>
 [Covers: PS_AI_REQ2]
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in the Covering Specification document now covers the PS_USB_REQ2 requirement in the 
Product Specification document. The orange icon on the 1.2 USB 2.0 Speeds section and 
its parent sections indicate that a change occurred to the project document source file 
outside of Requirements Gateway.

Note When you reload a project after making changes to a project document source 
file, Requirements Gateway highlights the added, deleted, modified, and moved 
elements with orange icons. The icons are temporary and disappear when you reload 
the project again without making any additional changes. If you want to persist the 
change information in the project, use marks or snapshots. Refer to the 
NI Requirements Gateway Help for more information about the orange icons, marks, 
and snapshots.

The Rule check node in the Selection column no longer appears because the project no longer 
contains an uncovered requirement.

Using the Impact Analysis View
The Impact Analysis view contains the same columns and tabs as the Coverage Analysis view, 
but displays all levels of downstream or upstream elements.

A Requirements Gateway project can include more documents than only one upstream 
document and one downstream document. Requirements can exist at more than one level, and 
you can use requirements at one level to cover requirements at the next immediate upstream 
level, but you must still cover the requirements at all levels to cover 100% of the requirements 
in the project.

For example, consider a project that contains three total documents, Doc1, Doc2, and Doc3, 
as shown in Figure 3-8:

Figure 3-8.  Traceability for Requirements at Multiple Levels in a Project

Doc1 Doc2 Doc3

Doc1_REQ1

Doc1_REQ2

Covers Doc2_REQ1

Covers Doc2_REQ2

Covers Doc1_REQ1

Covers Doc1_REQ2

Doc2_REQ1

Doc2_REQ2

Legend

Requirement Statement

Reference Statement

Coverage Link

Derived Requirement
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This project specifies the following requirements traceability:

• The document at the most upstream level, Doc1, specifies two requirements, Doc1_REQ1 
and Doc1_REQ2.

• The document at the intermediate level, Doc2, covers the two requirements in Doc1, but 
also specifies two additional requirements, Doc2_REQ1 and Doc2_REQ2, that a further 
downstream document must cover. The Doc2_REQ1 and Doc2_REQ2 requirements are 
called derived requirements because they are not defined at the most upstream level, but 
they must still be covered for the project to cover 100% of all requirements.

• The most downstream level document, Doc3, covers the two derived requirements the 
Doc2 specifies, Doc2_REQ1 and Doc2_REQ2. If Doc3 did not cover the derived 
requirements Doc2 specifies, the project would cover only 50% of all requirements.

Complete the following tutorials to use the Impact Analysis view to track requirements 
traceability across three levels of documents.

Adding a Third Document to a Project
Complete the following steps to add a third document to the project you created in Chapter 2, 
Managing Requirements.

1. Open <Requirements Gateway Public>\Tutorials\MyProject.rqtf if it is 
not already open.

2. Select File»Edit Project or click the Edit Project button, as shown in the following figure, 
on the toolbar in the main window to launch the Project pane of the Configuration 
dialog box.

3. Select the Covering Specification document on the Project Configuration pane.

4. On the Details tab of the Document Options pane, enter Design Specification in the 
Name control, select Text from the Type of Analysis ring control, and browse to 
<Requirements Gateway Public>\Tutorials\DesignSpec.txt in the File or 
Directory control.

5. Click the Add a document button to add a third document on the Project Configuration 
pane. Place the document below the Design Specification document.

6. On the Details tab of the Document Options pane, enter Test Specification in the 
Name control, select Text from the Type of Analysis ring control, and browse to 
<Requirements Gateway Public>\Tutorials\TestSpec.txt in the File or 
Directory control.
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7. Click the Add a cover button to add a covering link. Click the Test Specification 
document and then click the Design Specification document to create a covering link 
between the two documents, as shown in Figure 3-9.

Figure 3-9.  Two Levels of Covering Documents in the Project

8. Click OK to close the Configuration dialog box. 

9. Click Yes when Requirements Gateway prompts you to reanalyze the project.

Reviewing the New Documents
Complete the following steps to review the content of the two new documents.

1. Click the Impact Analysis View tab in the main window.

2. Select the Design Specification document and navigate to DesignSpec.txt.

3. Review the content of DesignSpec.txt, which contains similar sections and text 
elements as those in CoveringSpec.txt, but DesignSpec.txt contains 25 additional 
requirements.
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Some of the requirements in DesignSpec.txt also specify reference statements that 
cover requirements in ProductSpec.txt. For example, the 1.2 USB 2.0 Speeds section 
in DesignSpec.txt specifies DS_USB2_REQ1, DS_USB2_REQ2, and 
DS_USB2_REQ3 requirements, and each of these requirements includes a reference to the 
PS_USB_REQ2 requirement in ProductSpec.txt, as shown in Figure 3-10. 

Figure 3-10.  Requirements in DesignSpec.txt

4. Select the Test Specification document and navigate to TestSpec.txt.

5. Review the content of TestSpec.txt. The 1.2.1 Test USB 2.0 Low Speed section of 
TestSpec.txt includes the reference [Covers: DS_USB2_REQ1] to indicate that the 
section covers the DS_USB2_REQ1 requirement in DesignSpec.txt.

Because the Test Specification document includes references that cover requirements in the 
Design Specification document, and the requirements in the Design Specification 
document include references that cover requirements in the Product Specification 
document, the three documents together cover 100% of all requirements in the project. The 
requirements in the Product Specification document, which is the most upstream document, 
cannot be considered 100% covered by only the Design Specification document because 
the Design Specification document includes its own requirements that must be covered. 
The requirements in the Product Specification document can only be considered 100% 
covered when the Test Specification document, which is the most downstream document, 
also covers all requirements in the Design Specification document.

1.2. USB 2.0 Speeds  
 <<Hardware supports USB 2.0>> 
 
DS_USB2_REQ1: Low Speed 
 <<1.5 Mbps>> 
 [Covers: PS_USB_REQ2]  
DS_USB2_REQ2: Med Speed 
 <<12 Mbps>> 
 [Covers: PS_USB_REQ2]  
DS_USB2_REQ3: High Speed 
 <<480 Mbp>> 
 [Covers: PS_USB_REQ2] 
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6. Return to DesignSpec.txt, which also contains requirements that do not specify 
references to requirements in ProductSpec.txt. The 1.1 USB 1.0 Speeds section in 
DesignSpec.txt contains a reference to the PS_USB_REQ1 requirement in 
ProductSpec.txt and contains its own DS_USB1_REQ1 and DS_USB1_REQ2 
requirements, as shown in Figure 3-11.

Figure 3-11.  Derived Requirements in DesignSpec.txt

The DS_USB1_REQ1 and DS_USB1_REQ2 requirements are derived requirements. 
A requirement that includes a reference to a further upstream requirement is a non-derived 
requirement. The DS_USB2_REQ1, DS_USB2_REQ2, and DS_USB2_REQ3 
requirements in the Design Specification document, as shown in Figure 3-10, are 
non-derived requirements because these requirements specify references to further 
upstream requirements. A non-derived requirement denotes a dependency between the 
coverage of one or more upstream requirements and the coverage of the non-derived 
requirement.

7. Exit the application that displays DesignSpec.txt and TestSpec.txt.

1. USB Support
1.1. USB 1.0 Speeds 
 <<Hardware supports USB 1.0>>
 [Covers: PS_USB_REQ1]

DS_USB1_REQ1: Low Speed
 <<1.5 Mbps>>
DS_USB1_REQ2: High Speed
 <<12 Mbps>>

1.2. USB 2.0 Speeds 
 <<Hardware supports USB 2.0>>
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Performing Impact Analysis
Complete the following steps to use the Impact Analysis view to analyze the new documents.

1. Expand the Design Specification document in the Selection column to display the derived 
requirements, DS_USB1_REQ1 and DS_USB1_REQ2, and the non-derived requirements, 
DS_USB2_REQ1, DS_USB2_REQ2, and DS_USB2_REQ3, as shown in Figure 3-12. 
Requirements Gateway displays different icons for derived and non-derived requirements 
and displays an arrow icon to the right of a derived requirement and all parent elements of 
the requirement.

Figure 3-12.  Derived and Non-Derived Requirements

2. Expand the Product Specification document in the Selection column and select the 
PS_USB_REQ1 requirement. The Downstream Impact Information column displays only 
the covering 1.1 USB 1.0 Speeds section in the Design Specification document, as shown 
in Figure 3-13, because the 1.1 USB 1.0 Speeds section does not contain any non-derived 
requirements.

Figure 3-13.  PS_USB_REQ1 Downstream Impact Analysis
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3. Select the PS_USB_REQ2 requirement. The Downstream Impact Information column 
displays the non-derived requirements in the covering Design Specification document and 
the sections in the Test Specification document that cover the non-derived requirements, 
as shown in Figure 3-14.

Figure 3-14.  PS_USB_REQ2 Downstream Impact Analysis

Using the Graphical View
The Graphical view displays each document as an object with its traceability elements displayed 
in a tree view within the object. Solid lines represent traceability between requirement elements 
of a document and covering elements in another document. Dotted lines between objects 
represent links other than references, such as support, allocation, or validation information for 
requirements.

Complete the following steps to use the Graphical view to review project documents.

1. Open <Requirements Gateway Public>\Tutorials\MyProject.rqtf if it is 
not already open.

2. Click the Graphical View tab.

3. Select the PS_USB_REQ1 requirement in the Product Specification document. The 
Graphical view highlights the PS_USB_REQ1 requirement in the Product Specification 
document, the covering 1.1 USB 1.0 Speeds section in the Design Specification document, 
and the line between the elements, as shown in Figure 3-15.
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Figure 3-15.  PS_USB_REQ1 Selected in the Graphical View

4. Select the PS_USB_REQ2 requirement. The Graphical view highlights the 
PS_USB_REQ2 requirement in the Product Specification document, the derived 
requirements in the 1.2 USB 2.0 Speeds section of the Design Specification document that 
cover the PS_USB_REQ2 requirement, and the sections in the Test Specification document 
that cover the derived requirements in the Design Specification document.

5. Right-click the PS_USB_REQ2 requirement and select View Graph for Selection from 
the context menu to display only the highlighted elements from the three documents, as 
shown in Figure 3-16. 

Figure 3-16.  PS_USB_REQ2 Selected in the Graphical View

The yellow warning icon in the Graphical view indicates that the graph is only a partial 
view of the entire project.

6. Right-click the Graphical view and select Show All Elements from the context menu to 
display all the elements of the documents again.
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7. Click the header of the Test Specification document to select the entire document.

8. Right-click the Test Specification document and select Hide Selected Documents from 
the context menu. The Graphical view hides the Test Specification document, displays the 
traceability information for the remaining two documents, and again displays a yellow 
warning icon.

9. Right-click the Graphical view and select Show Hidden Documents from the context 
menu to launch a dialog box in which you can select a previously hidden document to show 
again in the Graphical view.

10. Select Test Specification from the list of documents and click OK to close the dialog box. 
The Graphical view shows the Test Specification document again.

11. Select File»Save or click the Save button, as shown in the following figure, on the toolbar 
in the main window to save the project.
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4
Generating Reports

You can generate built-in or custom reports that contain project analysis information. 
Requirements Gateway distinguishes between the following types of reports:

• Features Reports—Built-in report types for feature-related information. Features reports 
are available for all projects and stored in <Requirements Gateway>\config\
doc_models\Features Reports.xml.

• Library Reports—Built-in report types for project-related information. Library reports are 
available for all projects and stored in <Requirements Gateway>\config\
doc_models\Library Reports.xml.

• Public Reports—Custom reports available for all projects and stored in <Requirements 
Gateway Public>\Config\doc_models\Public Reports.xml.

• Project Reports—Custom reports available only for a specific project and stored in the 
same directory as the project in doc_models\Project Reports.xml.

Requirements Gateway installs the following features report:

• Features Information—Contains a summary of the releases and features that you define 
in the project.

Requirements Gateway installs the following library reports:

• Traceability Matrix—Lists the upstream-to-downstream covered requirements and the 
downstream-to-upstream covering references.

• Analysis Results—Summarizes the coverage analysis of the entire project.

• Project Description—Describes the project and the project documents.

• Upstream Impact Analysis—Lists the upstream traceability information for selected 
elements of the project.

• Downstream Impact Analysis—Lists the downstream traceability information for 
selected elements of the project.

• Synthesis of Added Information—Summarizes any added attributes, references, and text 
in the project.

• Rules Checking—Contains a summary of any rules the project violates.

• Requirement Attributes—Lists the requirements, attributes, and attribute values for one 
or more selected documents in the project.

• Requirement Details View—Lists the details of all the requirements, including the 
requirement text and added text, for one or more selected documents in the project.
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Refer to the NI Requirements Gateway Help for more information about the content of each 
default report type.

Generating a Built-in Report
Complete the following steps to generate a Project Description report for the project you created 
in Chapter 2, Managing Requirements, and modified in Chapter 3, Analyzing Requirements.

1. Open <Requirements Gateway Public>\Tutorials\MyProject.rqtf if it is 
not already open.

2. Select Reports»Library Reports»Project Description to launch the Save As dialog box.

3. Browse to the <Requirements Gateway Public>\Tutorials directory, enter 
ProjectDescription in the File name control, select a report format template from the 
Save as type ring control, and click Save. Requirements Gateway generates and displays 
the report in the default application for the format you specified, as shown in Figure 4-1.

Figure 4-1.  Project Description Report

4. Review the content of the report.

5. Exit the application that displays the report.
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Report Models and Templates
Report templates define the format and orientation of the report, and report models define the 
structure and content of the report. Requirements Gateway includes the following built-in 
templates:

• Rich Text Format in portrait or landscape orientation

• PDF in portrait or landscape orientation

• HTML

You can customize the default templates so that the generated report uses custom formatting. 
Refer to the NI Requirements Gateway Help for more information about customizing report 
templates.

Creating a Custom Report Model
Complete the following tutorials to create a custom report model that lists the requirements 
defined in each document of a project.

Note The content of this section is optional and intended for only advanced 
Requirements Gateway users.

Creating a New Custom Report Model
Complete the following steps to create a new custom report model for the project you created in 
Chapter 2, Managing Requirements, and modified in Chapter 3, Analyzing Requirements.

1. Open <Requirements Gateway Public>\Tutorials\MyProject.rqtf if it is 
not already open.

2. Select Reports»Edit Reports to launch the Reports pane of the Configuration dialog box.

3. Click the New Report button, as shown in the following figure, to add a new report under 
Project Reports, as shown in Figure 4-2.

GettingStartedwithNIRG.book  Page 3  Wednesday, March 14, 2018  8:24 AM



4-4 | ni.com

Chapter 4 Generating Reports

Figure 4-2.  New Report on the Reports Pane of the Configuration Dialog Box

The Reports pane contains the following sections:

• Report Configuration—A graphical model of the active report selected in the 
Reports List. Drag structures, data blocks, and other parameters from the Report 
Element pane and drop them on the Report Configuration pane to build the report 
model.

• Reports List—Lists the built-in and custom reports for the project.

• Toolbar—Buttons to create, rearrange, and delete reports from the Reports List. In 
addition, the Report elements button, as shown in the following figure, toggles the 
controls below the Reports List to display the properties for the item you select on the 
Report Configuration pane or the elements available to insert in the report. You can 
also double-click the Report elements button to launch a modal Report elements 
window.

1 Report Configuration 2 Reports List 3 Toolbar 4 Properties

2

3

4

1
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• Properties—Contains the following panes that display separately when you toggle 
the Report elements button:

– Selection Properties—Options for configuring the item you select in the Reports 
List or on the Report Configuration pane. The options available depend on the 
element you select.

– Report Elements—Structures, data blocks, and other parameters you can add to 
the report. When you select an element on the Report Configuration pane, 
Requirements Gateway highlights on the Report Elements pane the valid 
elements you can insert into the selected element.

The Report Elements pane contains the following tabs:

• Structures—Elements that define the structure of the report, such as text, 
paragraph, list, or table.

• Data—Elements associated with the object you select on the Report 
Configuration pane, such as the project, a document, or a requirement.

• Parameters—Data type elements you can pass to a structure element.

4. Enter Requirements in the English name control.

5. Select portrait.rtf from the Template ring control.

Configuring the Report
Complete the following steps to configure the custom report so that the report can loop on all 
documents in the project.

1. Select the Requirements root object of the report on the Report Configuration pane. 
Requirements Gateway highlights the Requirements object with hashing.

2. Click the Report elements button to display the Report Elements pane.

3. Click the Data tab.

4. Select the project»Contents»analyzed documents element and drag it to the Report 
Configuration pane to add the element to the report, as shown in Figure 4-3.

Figure 4-3.  Analyzed Documents Element Added to Report

The analyzed documents element instructs the report to loop on all documents in the 
project.

5. Click the Report elements button to display the Selection Properties pane. The Variable 
name control value defaults to doc1. This variable represents the active document while 
looping on all documents in the project.
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Adding Paragraph and Text Elements to the Report
Complete the following steps to add paragraph and text elements to the custom report.

1. Click the Report elements button to display the Report Elements pane and click the 
Structures tab.

2. Select the paragraph element and drag it to the analyzed documents element on the Report 
Configuration pane. Requirements Gateway adds a paragraph to the report for each 
document in the project. 

3. Complete the following steps to define the structure and content of the paragraphs.

a. Select the text element and drag it to the paragraph element. 

b. Click the Report elements button to display the Selection Properties pane and enter 
Document: in the English text control.

c. Click to the right of the Document: text element on the Report Configuration pane to 
highlight the entire paragraph element. Ensure that you select only the paragraph 
element and not the entire analyzed documents element.

d. Click the Report elements button to display the Report Elements pane and click the 
Data tab.

e. Select the doc1»Identification information»name element and drag the element to 
the right of the Document: text element, as shown in Figure 4-4.

Figure 4-4.  Paragraph and Text Elements Added to Report

Adding a Table Element to the Report
Complete the following steps to add a table element to the custom report.

1. Select the analyzed documents of project: doc1 element on the Report Configuration 
pane and click the Structures tab on the Report Elements pane.

2. Select the table element and drag it to the bottom of the analyzed documents of project 
element.

3. Drag a text element to each cell in the header row of the table, click the Report elements 
button to display the Selection Properties pane, and enter Requirement and Text, 
respectively, in the English text control for the table header elements.
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4. Select the area below the column headers, as shown in Figure 4-5.

Figure 4-5.  Inserted Column Text Elements

5. Click the Report elements button to display the Report Elements pane, click the Data tab, 
and drag the doc1»Contents»all requirements element to the selected area.

6. Click the Structures tab and drag the table row element to the requirements of doc1 
element.

7. Click the Data tab and drag the req1»Identification information»display element and the 
req1»Identification information»text element to the respective cells in the new table row, 
as shown in Figure 4-6.

Figure 4-6.  Final Custom Report

8. Click OK to close the Configuration dialog box.
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Generating a Custom Report
Complete the following steps to generate and save the custom report. 

1. Select Reports»Project Reports»Requirements from the main window to launch the 
Save As dialog box.

2. Enter Requirements in the File name control. Because you specified portrait.rtf 
as the template to use for the custom report in step 5 of the Creating a New Custom Report 
Model section, you cannot select a different report format template from the Save as type 
ring control.

3. Click Save to generate the report and launch the default application associated with.rtf 
files, as shown in Figure 4-7. 

Figure 4-7.  Final Generated Custom Requirements Report

4. Review the content of the report.

Note The report does not contain a table for the Test Specification document 
because the Test Specification document does not contain any requirements.

5. Exit the application that displays the report.

Refer to the NI Requirements Gateway Help for more information about customizing reports.
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The organization and format of data can vary between documents and does not always adhere to 
the format a built-in type defines. You can modify a project document source file to conform to 
the format a built-in type requires, or you can create a custom type that analyzes the format the 
project document source file uses.

This tutorial explains how to create a custom type based on the default Text type to capture 
traceability information from text files that use unique syntax for defining traceability 
information.

Reviewing File Formats
For most types, Requirements Gateway captures traceability information by translating a project 
document source file, such as a Microsoft Word document, into a text or XML intermediate file. 
The type analyzes the intermediate file and captures the required structure and traceability 
information. Refer to the NI Requirements Gateway Help for more information about the content 
and format of a text or XML intermediate file.

The Text type directly processes the content of a text file without using a translated 
intermediate file.

Complete the following steps to evaluate the format of custom text files so you can create a 
custom type to capture the traceability information from the files.

1. Open <Requirements Gateway Public>\Tutorials\
CustomTypeProject.rqtf.

2. Click the Management View tab. The Overall Quality pane indicates that the project 
specifies two documents, but does not define any requirements. 

3. Click the Coverage Analysis View tab. Requirements Gateway does not display any 
sections or requirements for the documents in the project because the documents use a 
syntax for requirements, references, and text elements that the default Text type cannot 
recognize.

4. Select the Product Specification document on the Project Overview pane and navigate to 
CustomProductSpec.txt.
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5. Review the content of CustomProductSpec.txt. Figure 5-1 shows a portion of 
CustomProductSpec.txt.

Figure 5-1.  Text from CustomProductSpec.txt

6. In Requirements Gateway, select the Covering Specification document on the Project 
Overview pane and navigate to CustomCoveringSpec.txt.

7. Review the content of CustomCoveringSpec.txt. Figure 5-2 shows a portion of 
CustomCoveringSpec.txt.

Figure 5-2.  Text from CustomCoveringSpec.txt

The CustomProductSpec.txt and CustomCoveringSpec.txt files contain the 
following traceability content format:

• Each document specifies two levels of sections. A minus character precedes a 
first-level section, and two space characters and a minus character precede a 
second-level section.

• The syntax [REQ: ID], where ID is a set of characters that represent a requirement 
ID, specifies requirements. An optional text label follows the requirement.

• The syntax [REF: ID], where ID is a set of characters that represents a requirement 
ID, specifies references.

• The # character specifies text associated with a section or requirement.

8. Exit the external applications.

Creating a Custom Type
When you create a custom type, you can duplicate and modify an existing type or create a new 
type. Because the custom Product Specification and Coverage Specification documents adhere 
to a very different content format than the format the default Text type defines, you must create 
a new type.

- USB Communication           # The hardware will 
    [REQ: USB1] USB1           # Low & High Speeds
    [REQ: USB2] USB2           # Low, Med, and High

- Analog Channels
  - Analog Input              # The hardware will
    [REQ: AI] Analog Input     # +/- 12 Volts
    [REQ: AI_COUNT] 10 channels

- USB Support
  - USB 1.0 Speeds            #Hardware supports USB
    [REF: USB1]

  - USB 2.0 Speeds            #Hardware supports USB
    [REF: USB2]

GettingStartedwithNIRG.book  Page 2  Wednesday, March 14, 2018  8:24 AM



© National Instruments | 5-3

Getting Started with NI Requirements Gateway

Note The content of this section is optional and intended for advanced 
Requirements Gateway users.

Complete the following steps to create a new type and configure the name, conversion tool, and 
editing tool for the type.

1. Select File»Edit Types or click the Edit Types button, as shown in the following figure, 
on the toolbar in the main window to launch the Types pane of the Configuration dialog 
box, as shown in Figure 5-3.

Figure 5-3.  Types Pane of the Configuration Dialog Box

The Types pane contains the following sections and panes:

• Types List—The list of available types. The Types List groups the types in folders that 
correspond to the read-only directories in the <Requirements Gateway>\
config\types directory.

The Types List also contains a public folder. You can place custom types and 
duplicates of the default types in the public folder to make the types available for all 
projects. Requirements Gateway stores the type definitions for the public folder in 

1 Types List
2 Toolbar

3 Selection Properties

2

3

1
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<Requirements Gateway Public>\Config\types\public\
public.types.

The final folder in the list contains the custom types defined for any projects located 
in the same directory as the current project file.

• Toolbar—Buttons to copy, delete, and add new elements to the Types List or to the 
elements of a specific type.

• Selection Properties—Options available for the type or type element you select in the 
Types List. Depending on the element you select in the Types List, the Selection 
Properties pane can display Analysis, Advanced Options, and Attributes tabs.

2. Select the Tutorials folder in the Types List.

3. Click the Add new type button, as shown in the following figure, on the toolbar to add a 
new type to the Tutorials folder in the Types List.

Note Use the Add XML type and Add a type for added elements buttons on the 
toolbar to create custom types for specific purposes. Refer to the NI Requirements 
Gateway Help for more information about XML types and types for added elements.

4. Enter My Type in the Name control on the Selection Properties pane.

5. Click the Analysis tab on the Selection Properties pane, if it is not already selected.

6. Select Text from the Convert tool ring control for Requirements Gateway to interpret any 
document that uses the type as a general text file, similar to the default Text type.

7. Select Text from the Edit tool ring control for Requirements Gateway to launch the default 
application associated with .txt files when you navigate to the document. 

8. Expand the My Type type node in the Types List.

The elements under a type in the Types List define how Requirements Gateway identifies 
traceability information in a text or XML intermediate file. Type elements use regular 
expressions to specify patterns in the text of the intermediate file for Requirements 
Gateway to identify instances of an element. Types that use XML intermediate files also 
specify the structure of the XML data to identify traceability information.

Table 5-1 lists the elements a type can define and the purpose of each element. Refer to the 
NI Requirements Gateway Help for more information about the elements that each built-in 
type defines.
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Table 5-1.  Type Elements

Element Description

Section Specifies how to identify and display the structural elements for a 
document. Examples of sections include headings in a text or 
Microsoft Word file; files in a directory; rows in a database; 
sequences, step groups, and steps in a TestStand sequence file; or 
front panels, diagrams, controls, and indicators in a LabVIEW VI.

Macro-Requirement Specifies how to identify and display macro-requirements for a 
document. A macro-requirement contains requirements and 
passes its attributes, text, or links onto those requirements. If a 
downstream element directly references a macro-requirement, 
the downstream element also covers all the requirements the 
macro-requirement contains

A macro-requirement element defines a starting location and 
an ending location, where Requirements Gateway associates 
any requirement element between the locations with the 
macro-requirement. For example, a macro-requirement element 
might interpret the syntax [MacroReq_ID] as a starting location 
and the syntax [End_of_MacroReq] as an ending location.

Requirement Specifies how to identify and display requirements for a 
document. For example, a requirement element might interpret 
[REQ: ID] as a requirement.

Entity Specifies how to identify and display an entity for a document. 
An entity element must contain a reference to a requirement, 
derived requirement, or macro-requirement and cannot reference 
itself. An entity element is similar to a section element, except that 
Requirements Gateway returns a rule violation if a reference 
element does not follow an entity element.

Reference Specifies how to identify references to requirements for a 
document. For example, a reference element might interpret 
[Covers: requirement ID] as a reference. Requirements 
Gateway does not display a reference as a separate element in 
the Coverage Analysis or Impact Analysis views but associates 
the reference with a preceding section or entity element. The 
Graphical view displays the references between requirements and 
covering elements as covering links.
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Attribute Specifies how to identify and display attributes of requirement 
elements for a document. An attribute element has a name and a 
Boolean, string, or numeric value. An attribute element might 
define the priority or owner of a requirement. A requirement can 
have only one attribute with a specific name.

Reference Attribute Specifies how to identify and display attributes of reference 
elements for a document. A reference attribute element has a 
name and a Boolean, string, or numeric value. A reference 
attribute element might define the type of coverage for a 
reference. A reference can have only one attribute with a specific 
name.

Link Specifies how to identify and display a non-covering relationship 
to a requirement or a reference to a section or entity. A link 
element must refer to the ID of the requirement, section, or entity. 
In the main window, you can navigate from the link element to the 
target requirement, section, or entity element.

Text Specifies how to identify descriptive information associated with 
a preceding section, entity, requirement, or attribute element.

Picture Specifies how to identify image files associated with a preceding 
section or entity element. Requirements Gateway supports images 
with BMP, PNG, Scalable Vector Graphics (SVG), and Windows 
Metafile (WMF) file formats.

Table Specifies how to identify and display tables with a preceding text 
element.

Table 5-1.  Type Elements (Continued)

Element Description

GettingStartedwithNIRG.book  Page 6  Wednesday, March 14, 2018  8:24 AM



© National Instruments | 5-7

Getting Started with NI Requirements Gateway

Adding Section Elements to the Type
Complete the following steps to add a hierarchy of section elements to the type you created.

1. Select the section element in the Types List.

2. Click the Add new type button to add a new section element named Section.

3. Enter ^-[ \t]*([^#\n\r]*).*$ in the Regular expression control on the Analysis 
tab, as shown in Figure 5-4.

Figure 5-4.  Section Element of the Custom Type
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The regular expression of a section element specifies the pattern of text to match in the source 
document to locate section elements and the text of section elements. Table 5-2 explains each 
component of the expression you entered in step 3.

4. With the new Section element still selected in the Types List, click the Add new type button 
to add a new section element named Section1 under the Section element. 

5. Enter ^[ \t][ \t]-[ \t]*([^#\n\r]*).*$ in the Regular expression control 
on the Analysis tab. This regular expression is similar to the expression in step 3, with 
two additional required spaces or tabs that precede the minus character.

Table 5-2.  Section Regular Expression Components

Expression 
Component Purpose

^ Specifies to start matching text patterns at the beginning of a line.

- Specifies that the next character must be the minus character.

[ \t]* The surrounding bracket characters specify that a character must match 
a space or a tab character, and the asterisk specifies that the text must 
contain zero or more matches.

( ) Specifies that any text that matches the inside pattern is returned as a 
field. This returns the text associated with the section.

[^#\n\r]* The ^ character specifies that the pattern cannot match the #, new line, 
or carriage return characters. This expression component forces the 
pattern to stop at the # character, if the # character exists.

.* Specifies to match zero or more of any of the characters. This pattern 
processes the # character, if it exists, and any subsequent text.

$ Specifies to match the end of a line.
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Adding a Requirement Element to the Type
Complete the following steps to add a requirement element to the type you created.

1. Select the requirement element in the Types List.

2. Click the Add new type button to add a new requirement element named Requirement.

3. Enter \[REQ: ([^\]]+)\][ \t]*([^#\r\n]*) in the Regular expression control. 
Table 5-3 explains each component of this expression.

Adding a Reference Element to the Type
Complete the following steps to add a reference element to the type you created.

1. Select the reference element in the Types List.

2. Click the Add new type button to add a new reference element named Reference.

3. Enter \[REF: ([^\]]+) in the Regular expression control on the Analysis tab. This 
regular expression specifies to return one or more characters between the space character 
after the [REF: characters and the closing bracket character. This expression returns the 
requirement ID for the reference.

Adding a Text Element to the Type
Complete the following steps to add a text element to the type you created.

1. Select the text element in the Types List.

2. Click the Add new type button to add a new text element named Text1.

3. Enter #[\t ]*(.+)$ in the Regular expression control. This regular expression 
specifies to return as the text value all characters between the # character and the end of 
line, excluding any preceding space or tab characters after the # character.

Table 5-3.  Requirement Regular Expression Components

Expression 
Component Purpose

\[REQ: Specifies to match the [REQ: characters followed by a space character.

([^\]]+) Specifies to return one or more characters that do not include the 
closing bracket character. This expression component returns the 
requirement ID.

\] Specifies to match the closing bracket character.

[ \t]* Specifies to match zero or more space or tab characters.

([^#\r\n]*) Specifies to return zero or more characters that do not include the 
#, new line, or carriage return characters. This expression component 
returns the requirement label.
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4. Click Apply to save the new type.

5. Click Yes when Requirements Gateway prompts you to reanalyze the project.

Applying a Custom Type in a Project
Complete the following steps to configure the documents in the project to use the new type:

1. Click the Project button in the Configuration dialog box to display the Project pane.

2. Select the Product Specification document on the Project Configuration pane and select 
My Type from the Type of Analysis ring control on the Details tab of the Document 
Options pane.

3. Select the Covering Specification document on the Project Configuration pane and select 
My Type from the Type of Analysis ring control on the Details tab of the Document 
Options pane.

4. Click OK to close the Configuration dialog box. 

5. Click Yes when Requirements Gateway prompts you to reanalyze the project.

6. Click the Management View tab in the main window and review the content of 
each document. The Overall Quality pane now indicates that the project specifies 
ten requirements and that the coverage percentage is 100%.
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Using External Applications 
with Requirements Gateway

Requirements Gateway supports capturing traceability information from the following National 
Instruments data sources:

• LabVIEW VIs, projects, classes, project libraries, and LLBs

• LabVIEW Unit Test Framework Toolkit test files, test vector files, and ATML report files

• LabWindows/CVI source code and function panel files

• TestStand sequence files, ATML report files, and XML report files

Requirements Gateway supports capturing traceability information from the following 
third-party data sources:

• Microsoft Word documents

• Microsoft Excel spreadsheets

• Microsoft Access databases

• Microsoft Visio project files

• IBM Rational DOORS databases

• IBM Rational RequisitePro databases

• PDF files

• Text files

• C, C++, and C# source code files

Refer to the NI Requirements Gateway Help for tutorials on using Requirements Gateway with 
LabVIEW, LabWindows/CVI, TestStand, and DOORS, and for more information about each 
type of the supported external applications.
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NI provides global services and support as part of our commitment to your success. Take 
advantage of product services in addition to training and certification programs that meet your 
needs during each phase of the application life cycle; from planning and development through 
deployment and ongoing maintenance.

To get started, register your product at ni.com/myproducts.

As a registered NI product user, you are entitled to the following benefits:

• Access to applicable product services.

• Easier product management with an online account.

• Receive critical part notifications, software updates, and service expirations.

Log in to your MyNI user profile to get personalized access to your services.

Services and Resources

• Maintenance and Hardware Services—NI helps you identify your systems’ accuracy and 
reliability requirements and provides warranty, sparing, and calibration services to help you 
maintain accuracy and minimize downtime over the life of your system. Visit ni.com/
services for more information.

– Warranty and Repair—All NI hardware features a one-year standard warranty that 
is extendable up to five years. NI offers repair services performed in a timely manner 
by highly trained factory technicians using only original parts at an NI service center.

– Calibration—Through regular calibration, you can quantify and improve the 
measurement performance of an instrument. NI provides state-of-the-art calibration 
services. If your product supports calibration, you can obtain the calibration certificate 
for your product at ni.com/calibration.

• System Integration—If you have time constraints, limited in-house technical resources, or 
other project challenges, National Instruments Alliance Partner members can help. To learn 
more, call your local NI office or visit ni.com/alliance.

GettingStartedwithNIRG.book  Page 1  Wednesday, March 14, 2018  8:24 AM

http://www.ni.com/myproducts
http://www.ni.com/services
http://www.ni.com/services
http://www.ni.com/calibration
http://www.ni.com/alliance


A-2 | ni.com

Appendix A NI Services

• Training and Certification—The NI training and certification program is the most 
effective way to increase application development proficiency and productivity. Visit 
ni.com/training for more information.

– The Skills Guide assists you in identifying the proficiency requirements of your 
current application and gives you options for obtaining those skills consistent with 
your time and budget constraints and personal learning preferences. Visit ni.com/
skills-guide to see these custom paths.

– NI offers courses in several languages and formats including instructor-led classes at 
facilities worldwide, courses on-site at your facility, and online courses to serve your 
individual needs.

• Technical Support—Support at ni.com/support includes the following resources:

– Self-Help Technical Resources—Visit ni.com/support for software drivers and 
updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting 
wizards, thousands of example programs, tutorials, application notes, instrument 
drivers, and so on. Registered users also receive access to the NI Discussion Forums 
at ni.com/forums. NI Applications Engineers make sure every question submitted 
online receives an answer.

– Software Support Service Membership—The Standard Service Program (SSP) is a 
renewable one-year subscription included with almost every NI software product, 
including NI Developer Suite. This program entitles members to direct access to 
NI Applications Engineers through phone and email for one-to-one technical support, 
as well as exclusive access to online training modules at ni.com/
self-paced-training. NI also offers flexible extended contract options that 
guarantee your SSP benefits are available without interruption for as long as you need 
them. Visit ni.com/ssp for more information.

• Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council 
of the European Communities using the manufacturer’s declaration of conformity. This 
system affords the user protection for electromagnetic compatibility (EMC) and product 
safety. You can obtain the DoC for your product by visiting ni.com/certification.

For information about other technical support options in your area, visit ni.com/services, 
or contact your local office at ni.com/contact.

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch 
office websites, which provide up-to-date contact information, support phone numbers, email 
addresses, and current events.
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Link Details view, 1-4
link element, 5-6

M
macro-requirement element, 5-5
main window, 1-3

figure, 1-3
menu bar, 1-3
project workspace, 1-4

Coverage Analysis view. See 
Coverage Analysis view

Graphical view. See Graphical view
Impact Analysis view. See Impact 

Analysis view
Link Details view. See Link Details 

view
Management view. See 

Management view
Requirement Details view. See 

Requirement Details view
status bar, 1-4
toolbar, 1-3

Management view, 1-4, 2-6
documents, navigating, 2-7
figure, 2-6
Overall Quality pane, 2-6
project document, reviewing (tutorial), 

2-7, 2-9
Project Overview pane, 2-6
Rule Check pane, 2-6

menu bar, main window, 1-3
Messages tab, 3-1
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Microsoft applications, using with 
Requirements Gateway, 2-1, 6-1

N
National Instruments

applications, using with Requirements 
Gateway, 2-1

data sources, using with Requirements 
Gateway, 6-1

navigating documents, 1-1, 2-7
New report button, 4-3

O
Options pane, 1-6
orange icons. See icons for modified elements
Overall Quality pane, 2-6

P
Parameters tab, 4-5
picture element, 5-6
project

covering document, adding to (tutorial), 
2-4

figure, 2-5
creating (tutorial), 2-1
custom type, applying in (tutorial), 5-10
document, adding to (tutorial), 2-3

figure, 2-4
pane. See Project pane

Project Configuration pane, 2-2
Project Description report, 4-1

generating (tutorial), 4-2
project document, reviewing (tutorial), 2-7, 

2-9
Project Files pane, 2-2
Project Options buttons, 2-3
Project Overview pane, 2-6
Project pane, 1-5, 2-2, 3-7

covering document, adding to (tutorial), 
2-4

Document Options pane, 2-3
document, adding to (tutorial), 2-3
figure, 2-2
Project Configuration pane, 2-2

Project Files pane, 2-2
Project Options buttons, 2-3

Project Reports folder, 4-1
project workspace, 1-4

Coverage Analysis view. See Coverage 
Analysis view

Graphical view. See Graphical view
Impact Analysis view. See Impact 

Analysis view
Management view. See Management 

view
public

directory, 1-6
reports, 4-1
types folder, 5-3

R
reference attribute element, 5-6
reference element, 5-5

regular expressions, creating for 
(tutorial), 5-9

references, 1-1
adding in project document (tutorial), 

3-5
element. See reference element
reviewing in project document (tutorial), 

2-9
regular expressions, 5-4

reference element, creating for (tutorial), 
5-9

requirement element, creating for 
(tutorial), 5-9

components (table), 5-9
section element, creating for (tutorial), 

5-7
components (table), 5-8

testing, 1-6
text element, creating for (tutorial), 5-9

Report Configuration pane, 4-4
Report elements button, 4-4
Report Elements pane, 4-5

Data tab, 4-5
Parameters tab, 4-5
Structures tab, 4-5

reports, 1-1, 4-1
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built-in, 4-1
custom, 4-1

configuring (tutorial), 4-5
creating new (tutorial), 4-3
elements

paragraph, adding (tutorial), 
4-6

table, adding (tutorial), 4-6
text, adding (tutorial), 4-6

example (figure), 4-8
generating (tutorial), 4-8

Features. See Features reports
generating, 4-1

built-in (tutorial), 4-2
custom (tutorial), 4-8

Library. See Library reports
models, 4-3

creating custom (tutorial), 4-3
creating new (tutorial), 4-3

pane. See Reports pane
Project, 4-1
Public, 4-1
templates, 4-3, 4-8

customizing, 4-3
customizing (note), 4-3, 4-8, 5-3
default, 4-3
default (note), 4-3, 4-8, 5-3
selecting (tutorial), 4-2

Reports List, 4-4
Reports pane, 1-6, 4-3

figure, 4-4
Report Configuration pane, 4-4
Report elements button, 4-4
Report Elements pane, 4-5

Data tab, 4-5
Parameters tab, 4-5
Structures tab, 4-5

Reports List, 4-4
Selection Properties pane, 4-5
toolbar, 4-4

Requirement Attributes report, 4-1
Requirement Details view, 1-4
Requirement Details View report, 4-1
requirement element, 5-5

regular expressions, creating for 
(tutorial), 5-9

components (table), 5-9
requirements, 1-1

analyzing coverage (tutorial), 3-2
covering multiple levels of 

requirements, 3-9
derived, 3-7, 3-10, 3-13, 5-5

figure, 3-6
element. See requirement element
icons, 3-11
managing, 2-1
multiple levels

calculating coverage, 3-9
traceability (figure), 3-6

reviewing in project document (tutorial), 
2-7

uncovered, 3-3
Requirements Gateway

Configuration dialog box. See 
Configuration dialog box

directory structure, 1-6
<Requirements Gateway Public> 

directory, 1-6
<Requirements Gateway> 

directory, 1-6
introduction, 1-1
main window. See main window
overview (figure), 1-2
starting, 1-2

rule checking, 2-6
report, 4-1
Rule check node in Coverage Analysis 

view, 3-3, 3-6
Rule Check pane in the Management 

view, 2-6
Rules Checking report, 4-1

S
section element, 5-5

regular expressions, creating for 
(tutorial), 5-7

components (table), 5-8
sections, reviewing in project document 

(tutorial), 2-7
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Selection column, 3-1
Selection Properties pane

Reports pane, 4-5
Types pane, 5-4

Snapshots pane, 1-6
status bar, 1-4
Structures tab, 4-5
Synthesis of Added Information report, 4-1

T
table element, 5-6
text element, 5-6

regular expressions, creating for 
(tutorial), 5-9

text intermediate file, 5-1
text, reviewing in project document (tutorial), 

2-7
Texts and Reference Attributes tab, 3-1
toolbar

main window, 1-3
figure, 1-3

Reports pane, 4-4
Types pane, 5-4

Traceability Matrix report, 4-1
type elements, 2-1, 2-7, 5-4

attribute, 5-6
descriptions (table), 5-5
entity, 5-5
link, 5-6
macro-requirement, 5-5
picture, 5-6
reference, 5-5
reference attribute, 5-6
requirement, 5-5
section, 5-5
table, 5-6
text, 5-6

types, 1-1, 1-5, 2-1, 2-7, 5-1
built-in, 2-1, 5-1
content formats, reviewing in a custom 

file format, 5-2
custom, 5-1

applying in a project (tutorial), 
5-10

creating new (tutorial), 5-2

elements
reference, adding (tutorial), 

5-9
requirement, adding (tutorial), 

5-9
section, adding (tutorial), 5-7
text, adding (tutorial), 5-9

file formats, reviewing for 
(tutorial), 5-1

pane. See Types pane
public, 5-3
regular expressions. See regular 

expressions
type for added elements (note), 5-4
XML types (note), 5-4

Types List, 5-3
Types pane, 1-5, 5-3

figure, 5-3
public folder, 5-3
Selection Properties pane, 5-4
toolbar, 5-4
Types List, 5-3

U
uncovered requirement, 3-3
Upstream Coverage Information column, 

3-1, 3-4
Upstream Impact Analysis report, 4-1

V
views, 1-4

Coverage Analysis, 1-4, 2-8, 2-9, 3-1, 
5-5

Graphical, 1-4, 3-12, 5-5
Impact Analysis, 1-4, 3-6, 5-5
Link Details, 1-4
Management, 1-4, 2-6
Requirement Details, 1-4

X
XML

intermediate file, 5-1
types (note), 5-4
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